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 8  Adding Graphics to a Presentation 

LESSON SKILL MATRIX

Skill Exam Objective Objective Number

Inserting and Formatting Images Display gridlines.

Crop images.

Resize images.

Apply styles.

Apply effects.

Compress media.

2.3.4

3.5.2

3.5.1

3.5.4

3.5.3

5.3.4

Adding Shapes to Slides Resize shapes.

Insert shapes.

Apply borders to shapes.

Apply styles to shapes.

Create custom shapes.

2.2.3

2.2.4

2.2.2

2.2.6

2.2.5

Ordering and Grouping Shapes Align and group shapes. 2.3.3

Creating a Photo Album Presentation

     KEY TERMS 
•  aspect ratio 

•  clip art 

•  constrain 

•  crop 

•  gridlines 

•  guides 

•  keyword 

•  order 

•  recolor 

•  reset 

•  rulers 

•  saturation 

•  Smart Guides 

•  tone 
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 You are the director of promotions for the Baldwin Museum of Science. The 

museum is especially interested in attracting teachers and students to their 

permanent exhibits, so you have scheduled appearances at a number of 

high schools in your area, where you plan to present PowerPoint slide 

shows about the museum and various aspects of science. PowerPoint’s 

graphics capabilities allow you to include and customize pictures, shapes, 

and movies to enliven your presentations. You can also add sounds to pro-

vide the fi nishing touch to a presentation. 

SOFTWARE ORIENTATION 

 Picture Tools 

 The Picture Tools Format tab (see Figure 8-1) enables you to apply formatting effects to images. 
After selecting the picture, apply formatting by clicking a button on this tab. 

 You can use the tools on the Picture Tools Format tab to apply picture styles, to add or remove its 
border, and to apply special effects like shadow, refl ection, and 3-D rotation. You can also crop and 
size the picture, correct the colors, and add artistic effects. 

Figure 8-1

Picture Tools Format tab

Picture Styles Picture Effects Picture Border Crop a picture Resize a picture

 INSERTING AND FORMATTING IMAGES 

 Images can be used to illustrate a slide’s content or provide visual interest to help hold the audi-
ence’s attention. You can insert images from the Offi ce.com image collection or a Bing image 
search, or you can insert a picture that you have created yourself or acquired from some other 
source. PowerPoint provides many options for improving the appearance of images after you have 
inserted them. You can reposition and resize them, rotate them, apply special effects such as Quick 
Styles, adjust brightness and contrast, and even recolor a picture for a special effect. If you do not 
like formatting changes you have made, you can reset an image to its original appearance. 

 Inserting Images from Office.com 

 Microsoft provides a large collection of images that PowerPoint users may use royalty-free in their 
presentations. To fi nd an appropriate image for your presentation at Offi ce.com, you search by 
keyword using the Online Pictures feature in PowerPoint. A  keyword    is a descriptor of an image’s 

The Bottom Line
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content, such as dog, tree, or fl ower. Each image has multiple keywords assigned to it, and so it can 
be found using a variety of keyword searches. 

 Some of the images from Offi ce.com are photographs, whereas others are clip art illustrations. 
 Clip art  illustrations are drawings composed of mathematically generated lines and shapes, 
 similar to the lines and shapes users can create using PowerPoint’s own drawing tools. Clip art 
illustrations increase the size of the presentation fi le less than photographs do, but they are less 
realistic-looking. PowerPoint 2013 does not distinguish between clip art and photographs when 
it searches Offi ce.com, and so your search results will likely contain a mixture of image types. 

 Offi ce 2013 uses the terms  image  and  picture  interchangeably. For example, the exam objectives 
reference  images  but those images are inserted using the  Pictures  and  Online Pictures  commands in 
the applications. The term  illustration  refers to drawn artwork such as clip art, and the term  pho-
tograph  refers to an image that was originally captured with a digital camera or scanned with a 
scanner. 

STEP BY STEP    Insert an Image from Offi ce.com 

  GET READY . Before you begin these steps, make sure that your computer is on. Log on, if 

necessary. 

1.   START  PowerPoint, if the program is not already running. 

2.  Locate and  OPEN  the  Exhibits  presentation and save it as  Exhibits Final . 

3.  Go to  slide 4  and click the  Online Pictures  icon in the empty content placeholder. The 

Insert Pictures dialog box opens. 

4.  Click in the  Offi ce.com Clip Art text box  and type  gears  (see Figure 8-2). 

Take Note

 Another Way 
 To insert Offi ce.com 

images on a slide that does not 
have a content placeholder, 
click the Online Pictures button 
on the Insert tab. 

Figure 8-2

Search for images with the 
keyword gears

Search button

Type search

keyword here

5.  Press  Enter , or click the  Search  icon [BTN-SEARCH]. PowerPoint searches for images 

that match the keyword and displays them in the dialog box. 

6.  Scroll  down  through the results and click a picture of    gears . Choose a  photo , rather 

than a line drawing. 

7.    Click  Insert . The image is inserted in the content placeholder.  

8.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 
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 This exercise inserted a photograph, rather than a clip art illustration. Photographs provide a more 
sophisticated and professional look for a presentation. Many clip art illustrations are humorous in 
appearance and may not be suitable for corporate communications or presentations on serious 
topics.  

 When you insert an image into a content placeholder, PowerPoint tries to fi t the graphic you select 
into the content placeholder. The image may not use up the entire placeholder area, depending on 
its size and shape. If you insert an image on a slide that does not have a placeholder, it will gener-
ally appear in the center of the slide. You can adjust the image’s size and position by dragging it, 
as you will learn later in this lesson. 

 If you decide you do not like an image you have inserted, you can easily delete it. Click the image 
to select it and then press Delete to remove it from the slide. 

 Inserting a Picture from a File 

 You do not have to rely on PowerPoint’s clip art fi les to illustrate your presentation. You can down-
load many pictures for free on the Internet or create your own picture fi les using a digital camera. 
In this exercise, you will insert a picture from a fi le that has already been created. 

 STEP BY STEP Insert a Picture from a File 

  USE  the  Exhibits Final  presentation that is still open from the previous exercise. 

1.    Go to  slide 3  and on the  Insert  tab, click the  Picture  s  button. The Insert Picture dialog 

box opens. 

2.  Navigate to the location of the  data fi les  for this lesson, click  Astronomy.jpg  

(see Figure 8-3), and then click  Insert . The dialog box may look different from the one 

shown in Figure 8-3, depending on your Windows version, the view in effect, and the 

other fi les in the folder. The picture appears on the slide (see Figure 8-4). 

 Another Way 
 Click the Pictures 

icon in any content placeholder 
to open the Insert Picture 
dialog box. 

Figure 8-3

Locate a picture fi le in the 
Insert Picture dialog box
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3.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 PowerPoint supports a variety of picture fi le formats, including GIF, JPEG, PNG, TIFF, BMP, 
and WMF. Be aware that graphic formats differ in how they store graphic information, so some 
formats create larger fi les than others.  

 If you take your own pictures using a digital camera, you do not have to worry about copyright 
issues, but you should pay attention to copyright permissions for pictures you locate from other 
sources. It is extremely easy to save any picture from a web page to your system. If you are going 
to use the picture commercially, you need to contact the copyright holder, if there is one, and ask 
for specifi c permission to reuse the picture. 

 Some U.S. government sites, such as NASA (the source of the picture you inserted in the previous 
exercise), make images available without requiring copyright permission. 

 Changing a Picture 

 After inserting a picture, if it is not what you want you can easily delete it and insert a different 
one, either from an online source or from another fi le. However, if you have applied formatting to 
the picture, as you will learn to do in the remainder of this chapter, you might not want to lose the 
formatting and start over. In situations such as this, you can use the Change Picture command to 
swap out the picture without losing any of the formatting you have applied to the previous picture. 

 STEP BY STEP Change a Picture 

  USE  the  Exhibits Final  presentation that is still open from the previous exercise. 

1.  Go to  slide 4 . 

2.     Right-click  the picture and click  Change Picture   . The Insert Pictures dialog box opens. 

3.    Click the  Browse  hyperlink next to  From a fi le . The Insert Picture dialog box opens. 

(This is a different dialog box from the one in step 2.) 

4.  Navigate to the folder containing the  data fi les  for this lesson and click  Gears.jpg.  

5.  Click  Insert . The picture is replaced.  

6.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Using the Ruler, Gridlines, and Guides 

 In Normal, Outline, and Notes Page views, you can turn on PowerPoint’s horizontal and vertical 
 rulers , which help you measure the size of an object on the slide, as well as the amount of space 
between objects.  Smart Guides  appear automatically as you drag objects on a slide to help you 
line them up with other content on the slide. If you want guide lines that stay visible, turn on the 
Guides feature. These drawing  guides  are movable vertical and horizontal non-printing lines that 
you can use when positioning objects on a slide. PowerPoint also provides  gridlines , a set of dotted 
horizontal and vertical lines that overlay the entire slide. In this exercise, you learn how to use the 
ruler, guides, and gridlines to position objects so that they align with other objects on a slide and 
appear consistently throughout a presentation. 

Take Note

2.3.4

 How do you display 
gridlines? 
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STEP BY STEP Use the Ruler, Gridlines, and Guides 

USE  the Exhibits Final presentation that is still open from the previous exercise. 

1.  Go to  slide 3 . On the View tab, click  Ruler  if this option is not already selected. The 

vertical and horizontal rulers appear in the Slide pane. 

2.  Click to mark the  Gridlines     check box . A grid of regularly spaced dots overlays the slide 

(see Figure 8-4). 

 Another Way 
 Right-click a slide 

outside of any placeholder, and 
then click Ruler. 

Figure 8-4

Rulers and gridlines

Vertical ruler

Horizontal ruler Gridlines

Check boxes for Ruler,

Gridlines, and Guides
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3.  Click to mark the  Guides  check box. The default vertical and horizontal drawing guides 

display, intersecting at the center of the slide, as shown in Figure 8-5. 
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4.  The guides will be more useful for positioning pictures in this presentation, so you can 

turn off the gridlines: click the  View  tab, and click  Gridlines  in the Show group to 

remove the check mark and hide the gridlines. 

5.  Click the  text   box  on slide 3 that contains the bulleted list to activate it. You will use the 

text box’s border to help you position guides. 

6.  Click the  vertical guide . As you hold down the mouse button, a ScreenTip appears that 

shows the current position of the guide—0.0, indicating the guide is at the 0 inch mark 

on the horizontal ruler. 

7.  Click and drag the  guide to the   left  until it aligns on the left border of the text 

placeholder. The ScreenTip should read approximately 4.50 with a left-pointing arrow. 

Release the mouse button to drop the guide at that location. 

8.  Click the  horizontal guide  to the right of the planet picture and drag  upward  until the 

ScreenTip reads  1.67  with an upward-pointing arrow. Drop the  guide . It should align 

with the top of the capital letters in the fi rst line of the text placeholder. 

9.  Click the  vertical guide  you positioned near the left edge of the slide, hold down  Ctrl , 

and drag a  copy of the guide  to the right until the ScreenTip reads  4.50  with a right-

pointing arrow. Drop the guide by  fi rst releasing the mouse button  and then releasing 

the Ctrl key. Your slide should look like Figure 8-6. 

 Another Way 
 Right-click an 

empty area of the slide, point 
to Grid and Guides, and select 
Guides from the submenu. Or, 
click the dialog box launcher in 
the Show group on the View 
tab to open the Grid and 
Guides dialog box and then 
mark or clear the Guides check 
box. You can also press Alt 1 F9 
to toggle guides on or off. 

Figure 8-5

A ScreenTip shows the guide’s 
position on the ruler

Screen Tip

Guides 
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10.  Go to  slide 4 , click the  gear picture , and drag it until the  upper-left corner  of the picture 

snaps to the intersection of the vertical and horizontal guides. Your slide should look 

like Figure 8-7. 

Figure 8-6

Drawing guides positioned on 
the slide

Vertical guide at the

4.5" mark on the ruler

Horizontal guide

aligned with top of text

Figure 8-7

Picture repositioned using
the guides

Picture aligns with the

intersection of the guides
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11.  Go to  slide 5  and drag the  picture down and to the left  so its upper-right corner snaps 

to the intersection of the guides. 

12.  Go to  slide 6  and drag the  picture up and to the left  to snap to the intersection of the 

two guides. 

13.  On the View tab, clear the  Guides  check box to turn off the guides. 

14.    Go to  slide 7  and drag the  picture up on the slide  until you see a faint red dotted 

horizontal line at its top. This Smart Guide indicates that the picture is at the same 

vertical position as the text box to its left (see Figure 8-8). Release the  mouse button  to 

drop the picture in the new location. 

 If you do not like the Smart Guides feature, you can turn it off. Right-click an empty area of the 
slide, point to Grid and Guides, and click Smart Guides. Repeat that same procedure to re-enable 
the feature. 

15.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 By default, objects “snap”—automatically align—to the gridlines even if the gridlines are not 
currently displayed. This feature can be helpful when you are positioning objects, but you may 
sometimes fi nd that it hinders precise positioning. You can temporarily override the “snapping” by 
holding down Alt as you drag an object. Or, you can display the Grid and Guides dialog box (by 
clicking the dialog box launcher in the Show group on the View tab) and deselect the  Snap objects 
to grid  check box. 

Rotating and Flipping an Image 

 You can rotate or fl ip pictures to change their orientation on a slide. Rotating spins the picture 
around its center; fl ipping creates a mirror image of it. Rotating and fl ipping can provide additional 
visual interest for a graphic or fi t it more attractively on a slide. 

Take Note

Figure 8-8

Smart Guides can help you 
position objects without using 

traditional guides

Smart Guide
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STEP BY STEP Rotate and Flip an Image 

USE  the  Exhibits Final  presentation that is still open from the previous exercise. Save the 

fi le as  Exhibits Final Version 2 . 

1.  Go to  slide 3 , and click the  picture  to select it. 

2.  Click the  Picture Tools Format  tab, click  Rotate   Objects  in the Arrange group, and then 

click  Flip Horizontal  in the drop-down menu that appears. The picture reverses its 

orientation so the planet is on the right and its moons are on the left (see Figure 8-9). 

3.    Drag the  picture up into the upper-right corner  of the slide, so that the top and right 

edges of the picture align with the top and right edges of the slide (see Figure 8-10).  Another Way 
 Click the Arrange 

button on the Home tab, click 
Rotate, and choose a rotation 
option. 

Figure 8-9

The picture has been 
fl ipped horizontally

Rotate Objects button

Flipped picture
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4.  Go to  slide   4  and click the  picture  to select it. 

5.  Click the  Picture Tools Format  tab, click  Rotate   Objects , and then click  Rotate   Left     90 °  .  

6.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 PowerPoint offers some set rotation options, such as rotating right or left 90 degrees. For more 
control over the rotation, you can drag the rotation handle above the selected object, or click More 
Rotation Options on the Rotate button’s menu to open the Format Picture task pane, where you 
can type a specifi c rotation amount in the Rotation text box. 

 Cropping an Image 

 You have several options for adjusting the size of a picture or other graphic object. You can crop an 
object to remove part of the object, drag a side or corner, specify exact measurements for an object, 
or scale it to a percentage of its original size. When you  crop  a picture, you remove a portion of the 
graphic that you think is unnecessary in order to focus attention on the most important part of a 
picture. The portion of the picture you cropped is not deleted. You can restore the cropped material 
by using the crop pointer to drag outward to reveal the material that was previously hidden. 

STEP BY STEP  Crop an Image 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise. 

1.    Go to  slide   6  and click the  picture  to select it. 

2.    Click the  Picture Tools Format  tab. 

3.  Click the  Crop  button in the  Size  group. (Click the  upper part of the button , not the 

arrow below it.) The pointer changes to a crop pointer and crop handles appear around 

the edges of the picture. 

3.5.2

 How do you crop an image? 

Figure 8-10

Drag the picture to the 
upper-right corner of the slide

Place the picture here
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4.  Click to  p  osition the pointer  on the left side crop handle and drag  inward to crop the 

picture  so that there is an approximately equal amount of white space to the left of the 

protractor and to the right of it (see Figure 8-11).  

Figure 8-11

Drag the crop handle inward to 
remove a portion of the picture

Drag crop handle

Crop button

5.  Release the  mouse button , and then click the  Crop  button again to complete the crop. 

6.  On the View tab, mark the  Guides  check box to turn the guides back on. 

7.  Click and drag the  cropped picture  back up to the intersection of the two guides. Your 

slide should look similar to Figure 8-12. 

Figure 8-12

The picture has been cropped 
and repositioned

8.  On the View tab, clear the  Guides  check box to turn the guides off. 

9.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 
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 Resizing an Image 

 In this exercise, you will learn three ways to adjust the size of a picture: by simply dragging a cor-
ner, by setting measurements in the Size and Position controls in the Format Picture task pane, 
and by setting a measurement in the Size group on the Picture Tools Format tab. You can use these 
options to resize any object on a slide. 

 Generally, you will want to maintain a picture’s  aspect ratio  when you resize it. The aspect ratio 
is the relationship of width to height. By default, a change to the width of a picture is also applied 
to the height to maintain aspect ratio. In some instances, you may want to distort a picture on 
purpose by changing one dimension more than the other. To do so, you must deselect the  Lock 
aspect ratio  check box in the Size section of the Format Picture task pane. You are then free to 
change width and height independently. Alternatively, you can drag a side selection handle on the 
object (not a corner); this action allows you to adjust each dimension separately. 

 In the following exercise, you will resize an object and change its aspect ratio. 

STEP BY STEP  Resize an Image 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise. 

1.  Go to  slide 3  and click the  picture  to select it. 

2.  Click and drag the  lower-left corner of the picture  diagonally until the left edge of the 

picture aligns with the  0  mark on the horizontal ruler (see Figure 8-13). (Do not worry 

that the slide title is partially covered; you will fi x this problem in a later exercise.) 

3.5.1

 How do you resize an 
image? 

Figure 8-13

Resize a picture by dragging
a corner

Left edge aligns with 0 on horizontal ruler
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 If you have diffi culty getting the size right because Smart Guides pop up to snap the image into 
alignment with other objects on the slide, turn off Smart Guides temporarily. Right-click an 
 empty area of the slide, point to Grid and Guides, and click Smart Guides. Repeat that same 
 procedure to re-enable the feature. 

Take Note
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3.  Go to  slide 4  and click the  picture  to select it. 

4.   Right-click  the picture, and then click  Size and Position  from the shortcut menu. The 

Format Picture task pane appears.  

5.  Click the  Lock aspect ratio  check box to deselect this option. You can now specify the 

height and width independently. 

6.    In the Size area of the task pane, click the  Reset  button to remove previous 

modifi cations made to this picture (rotation) from an earlier exercise. 

7.  Click the  Height   up arrow  until the height is  3.7  inches. Click the  Width   down arrow  

until the width is  3  inches.  

8.  Click to expand the  Position  heading in the task pane, and set the  Vertical position  to 

 2.1  (see Figure 8-14). This action is an alternate way of moving a picture. 

 Another Way 
 You can open the 

Format Picture task pane by 
clicking the dialog box 
launcher in the Size group on 
the Picture Tools Format tab. 

9.  Close the  task pane .  

10.  Go to  slide 5  and click the  picture  to select it. 

11.  Click the  Picture Tools Format     tab , and then click the  Width   down arrow  in the Size 

group until the picture’s width is  4.2  inches (see Figure 8-15). 

 Another Way 
 You can also 

specify a percentage of the 
original dimensions, instead of 
an exact size. This action is 
called  scaling  .  

Figure 8-15

Set the width on the Ribbon

Set Width to 4.2"

12.  Turn the  guides back on , and then drag the  picture to align its upper  -  right corner  with 

the intersection of the two guides near the right edge of the slide. Then turn the  guides 

off  again. 

Figure 8-14

Format Picture task pane
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13.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 As you saw in step 6, you can  reset  a picture to its original appearance from the task pane to re-
move any changes you have made to it. You can also reset a picture on the Picture Tools Format 
tab. To do so, click the down arrow on the Reset Picture button, and then click Reset Picture & 
Size. This action resets not only the picture size, but also any formatting you may have applied to 
it (which you will learn to do later in this lesson). 

 Applying a Style to an Image 

 PowerPoint provides a number of styles you can use to apply borders and other effects to images. 
You can easily apply styles with heavy borders, shadow and refl ection effects, and different shapes 
such as ovals and rounded corners. Use styles to dress up your images or format them consistently 
throughout a presentation. 

STEP BY STEP  Apply a Style to a Picture 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise. 

1.    Go to  slide 5  and click the  picture  to select it if necessary. 

2.    On the Picture Tools Format tab, click the  More  button in the Picture Styles group. The 

Picture Styles gallery appears. 

3.    Click the  Soft Edge Oval  style. Your picture should look like the one in Figure 8-16. 

3.5.4

How do you apply styles to 
images?

4.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

Figure 8-16

The Soft Edge Oval style gives 
the picture a different look

Soft Edge Oval
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 The style’s picture borders are black or white by default, but you can apply any color to the border 
using the Picture Border button after applying the style.  

 If you have a number of pictures in a presentation, be careful not to apply too many different styles 
to the pictures. Using just one or two styles throughout a presentation makes it seem more unifi ed 
and consistent. 

 Correcting Brightness and Sharpness 

 You may need to modify a picture’s appearance to make it show up well on a slide. This action can 
be particularly important with pictures you insert from fi les, which may not have been photographed 
using the optimal settings. In PowerPoint 2013 Brightness, Contrast, and Sharpness/Softness are all 
controlled from the same section of the Format Picture task pane. For presets, you can select from the 
Corrections button’s menu. For precise amounts, you can use the task pane. 

STEP BY STEP  Adjust a Picture’s Brightness and Sharpness 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise. 

1.    Go to  slide 6  and click the  picture  to select it. This picture is a bit too bright. 

2.    Click the  Picture Tools Format  tab. 

3.  In the Adjust group, click  Corrections . A palette of corrections appears (see Figure 8-17). 

Notice that there are  two sections : Sharpen/Soften and Brightness/Contrast. The center 

selection in each section is the current setting. 

 Take Note 

4.  In the Brightness/Contrast section, click the  Brightness   2  20% Contrast  ;   0% (Normal)  

setting. 

5.    Click the  Corrections  button again, reopening the menu. 

6.  In the Sharpen/Soften section, click  Sharpen  :   25% . 

7.    Click the  Corrections  button again, and click  Picture Corrections Options . The Format 

Picture task pane opens. 

8.    Drag the  Sharpness   slider to 30%  and drag the  Contrast slider   to   5  %  (see Figure 8-18).  

Another Way
You can use the 

increment arrow buttons to set 
the values instead of dragging 
if you fi nd that easier.

Figure 8-17

Select from the Corrections 
button’s palette

Current setting for

sharpness/softness

Current setting for

brightness/contrast
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9.  Close the task pane. 

10.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

   Applying Color Adjustments 

 Color adjustments enable you to correct minor exposure or color problems in an image without 
having to open it in a third-party photo editing program. You can improve the look of a picture 
by making subtle adjustments, or apply dramatic adjustments that distort the image for a special 
effect. 

 Each of the three sections on the Color button’s palette controls a different aspect of the color. 
Color  Saturation    determines the intensity of the color, ranging from 0% (grayscale, no color) to 
400% (extremely vivid color). Color  Tone  refers to the subtle tint of the image’s color, ranging 
from warmer shades (more red) to cooler shades (more blue).  Recolor    enables you to select color 
wash to place over the image or to set it to grayscale, black and white, or washout. In this exercise, 
you will make some color corrections on a photo. 

STEP BY STEP  Apply Color Adjustments 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise. 

1.  Go to  slide 5  and click the  picture  to select it. 

2.    Click the  Picture Tools Format    tab. 

3.  In the Adjust group, click  Color . A palette of color choices appears (see Figure 8-19). 

Figure 8-18

Correct a picture from the 
Format Picture task pane

Sharpness slider

Contrast slider
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4.  In the Color Saturation section, click  Saturation   200  % . 

5.  Click  Color  again to reopen the palette, point at  More Variations , and in the Standard 

Colors group, point to  Light Green    to see a preview applied to the picture. Click  away 

from the menu  to close the menu without making a selection. 

6.    Click  Color  again to reopen the palette, and click  Picture   Color Options   . The Format 

Picture task pane opens. 

7.  In the Picture Color section under Color Tone, set the  Temperature  value to  7  ,000  by 

typing 7,000 in the Temperature text box (see Figure 8-20). 

8.    Close the  task pane . 

9.   SAVE  the presentation. 

Figure 8-19

Select color correction presets 
for the picture
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  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Adding Effects to an Image 

 There are two types of effects that you can apply to a picture: picture effects (such as Glow, Shad-
ow, and Bevel), which affect the outer edges of the picture, and artistic effects (such as Chalk 
Sketch or Line Drawing), which affect the picture itself. 

 Adding Picture Effects 

 Picture effects apply to the edges of a picture, and not to the picture itself. For example, you can 
apply a beveled frame to a picture, or make its edges fuzzy. In the following exercise, you will apply 
a bevel and a glow effect.  

  STEP BY STEP  Add Picture Effects to an Image 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise. 

1.  Go to  slide 4  and click the  picture  to select it. 

2.    Click the  Picture Tools Format  tab. 

3.    Click the  Picture Effects  button in the Picture Styles group, point to  Preset  in the 

drop-down menu that appears, and click  Preset   2 . A preset formatting effect is applied. 

4.    Click the  Picture Effects  button, point to  Bevel , and click  Art Deco . A different bevel is 

applied. 

5.    Click the  Picture Effects  button, point to  Glow , and click  Periwinkle  ,   8 point glow  ,   

Accent color 5 . An 8-point periwinkle blue glow is placed around the picture. 

3.5.3

How do you apply effects to 
an image?

Figure 8-20

Fine-tune color corrections 
from the Format Picture 

task pane

Temperature
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6.    Click  away from the picture  to deselect it so you can see it more clearly. The slide 

should look like Figure 8-21. 

7.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Adding Artistic Effects 

 Artistic effects enable you to transform the picture itself, not just the outer edges. Some of the 
effects, such as the Paint Strokes effect you apply in this exercise, can even make the picture look 
less like a photograph and more like a hand-drawn work of art. 

  STEP BY STEP  Add Artistic Effects to an Image 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise. 

1.    Go to  slide 7  and click the  picture  to select it. 

2.  Click the  Picture Tools Format  tab. 

3.    Click  Artistic Effects  in the Adjust group to open the Artistic Effects gallery, and point 

to  several different settings  in the gallery. Observe their  effect  on the image behind 

the open palette. 

4.    Click  Paint Strokes . (It is the second one in the second row.) Your slide should look 

similar to Figure 8-22. 

Figure 8-21

The slide after picture effects 
have been applied 

to the picture
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5.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Removing an Image’s Background 

 Some graphic fi le formats allow a photo to have a transparent background, but most photos do not 
use transparency. If you want to make areas of a certain color transparent in the copy of the photo 
you use in your presentation, you can do so with the Remove Background command. You will 
learn how to use the Remove Background command in this exercise. 

STEP BY STEP  Remove an Image Background 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise. 

1.    Go to  slide 3  and click the  picture  to select it. 

2.  On the Picture Tools Format tab, click  Remove Background . The Background Removal 

tab appears on the Ribbon, and the picture turns purple except for one planet (see 

Figure 8-23). The purple areas are the parts that will be removed. 

Figure 8-22

Apply artistic effects 
to an image

Paint Strokes

The Paint Strokes

effect has been

applied to this picture
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3.    Zoom in to  100%  zoom using the Zoom slider in the bottom right corner of the 

PowerPoint window, and adjust the  display  so you can see the photo clearly. 

4.  Notice that inside the picture is a rectangular border with selection handles. Only 

content within this rectangle will be kept. Drag the  corner selection handles  of that 

rectangle so that the entire picture is inside that area. 

5.  On the Background Removal tab, click  Mark Areas to Keep . 

6.    Click and drag to  draw across   one of the planets . If the entire planet does not turn back 

to its original color with a single click, continue  clicking different parts  of it until the 

entire planet appears in its original color. Zoom in  further if needed  to see what you 

are doing. 

 If you make a mistake and click too much, and the whole background turns black, press Ctrl 1 Z 
to undo your last action and try again. 

7.  Repeat  step 6  until only the background is purple, and all planets appear in their 

original colors (see Figure 8-24). 

Troubleshooting

Figure 8-23

Tools for removing 
a photo’s background

Zoom slider

Only content within this

inner border will be kept
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8.    Click  Keep Changes  in the Close group of the Background Removal tab to fi nalize the 

background removal. Now that the background is removed, the slide title is no longer 

partly obscured.  

9.    Click  away from the image  to deselect it. 

10.    Click  Fit Slide to Current Window  in the status bar at the bottom of the PowerPoint 

window to reset the slide’s zoom (see Figure 8-25). 

Figure 8-24

Adjust the areas to keep

Figure 8-25

The completed slide with 
background removed from 

the photo

Fit Slide to Current

Window button
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11.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 The amount of effort required to remove a photo’s background accurately depends on the individ-
ual photo and on the amount of contrast between the background and the foreground image. You 
may need to click several times on different parts of the image to mark them to keep. Other pho-
tos may be almost perfectly done with the default setting. 

 It is easy to make a mistake when marking areas for background removal. The Undo command 
(Ctrl 1 Z) easily reverses your last action and can be used when a particular marked area does not 
turn out as you expect. You can also use the Mark Areas to Remove command on the Background 
Removal tab to mark areas that have erroneously been marked for keeping. 

 Compressing the Images in a Presentation 

 When adding pictures to a presentation, you may need to consider the ultimate size of the presen-
tation. Pictures will add considerably to the presentation’s fi le size. This increased fi le size can 
make a large presentation diffi cult to store or work with. Compressing images reduces the fi le size 
of a presentation by reducing its resolution (dots per inch). This action can make the presentation 
easier to store and to email to others, and it speeds up display if you have to work on a slow pro-
jector or computer system. 

STEP BY STEP  Compress the Images in a Presentation 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise. 

1.    Click the  File  tab, and make a  note  of the fi le size under the  Properties  heading. Then 

press  Esc  to return to the presentation. 

2.  Click any picture in the presentation to select it, and then click the  Picture Tools Format  

tab. 

3.  Click  Compress Pictures  in the Adjust group. The Compress Pictures dialog box opens. 

4.    Click the  E  mail (96 ppi)  option button. 

5.  Clear the  Apply only to this picture  check box (see Figure 8-26). If you wanted to 

compress only the selected picture, you would leave this option checked.  
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6.  Click  OK . 

7.   SAVE  the presentation. PowerPoint applies the compression settings you selected. 

8.  Repeat  step 1  to recheck the presentation’s fi le size. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 You will learn more about sharing a presentation in Lesson 10. 

 The compression utility allows you to choose several options that can reduce fi le size. You can 
choose to delete the hidden portions of cropped pictures, for example. You can also choose a target 
output setting. If you know your slides will be presented on the web or projected on a monitor, you 
can choose the lowest dpi (dots per inch) setting. Presentations to be shown on a screen do not 
have to have the same quality as materials that might be printed because the monitor screen itself 
is limited in the quality it can display. You can compress pictures individually, or apply the same 
setting to all pictures in the presentation. 

 ADDING SHAPES TO SLIDES 

 PowerPoint offers drawing tools that enable you to create both basic and complex drawings. Use 
line tools and shapes to construct the drawing. You can easily add text to shapes to identify them 
and format the drawing using familiar fi ll, outline, and effects options. 

 Drawing Lines 

 PowerPoint supplies a number of different line tools so you can draw horizontal, vertical, diagonal, 
or free-form lines.  

 To draw a line, you select the Line tool, click where you want to begin the line, hold down the 
mouse button, and drag to make the shape the desired size.  

5.3.4

How do you compress 
images?

Cross 
Ref

The Bottom Line

Figure 8-26

Compress the pictures in the 
presentation

Compress

Pictures button
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 You can use the Shift key to  constrain  some shapes to a specifi c appearance. For example, you can 
hold down Shift while drawing a line to constrain it to a vertical, horizontal, or 45-degree diagonal 
orientation. 

STEP BY STEP  Draw Lines 

  USE  the  Exhibits Final   Version 2  presentation that is still open from the previous exercise, 

and save it as  Exhibits Final Version 3 . 

1.  Go to  slide 8 . You will create a map on this slide to show potential visitors how to get to 

the museum. As you work, refer to  Figure 8-  27  for position of objects. 

2.  Click the  View  tab, and then click  Gridlines  to turn gridlines on. 

3.  Create the  fi rst street  for the map as follows: 

a.  Click the  Home  tab, and then click the  Shapes  button to display the gallery of 

drawing shapes. 

b.  Click  Line  in the Lines group. The pointer takes the shape of a crosshair. 

c.  Locate the intersection of  vertical and horizontal gridlines  below the letter  n  in  John , 

click at the  intersection , and drag  downward  to create a vertical line three “blocks” 

long. 

 You can also access the Shapes gallery on the Drawing Tools Format tab. 

4.    Add the street name as follows: 

a.    Click  Text Box  on the Insert tab, click  anywhere  on the slide, and type the text 

 Matthews Pike . 

b.    Click the  outer border  of the text box to select all content within the text box, and 

change the font size to  16 . 

c.    On the Drawing Tools Format tab, click  Rotate , and click  Rotate Left 90º . 

d.    Move the  rotated street name  just to the left of the vertical line (see Figure 8-27). 

5.    Select the  Line  tool again, hold down  Shift , and draw the  di  agonal line  shown in 

Figure 8-27. 

 Holding down the Shift key constrains the line to be exactly 45 degrees or exactly vertical or hor-
izontal as you drag. 

 Take Note 

 Take Note 

Figure 8-27

The streets and street names 
have been added
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6.    Select the  Line  tool again and draw the  hori  zontal line  shown in Figure 8-27. 

7.    Add the  street name  for the diagonal street as follows: 

a.    Insert a  text box  anywhere on the slide, and type  Magnolia Parkway . 

b.    Change the font size to  16 . 

c.    With the text box still selected, click  Arrange , point to  Rotate , and click  More 

Rotation Options   . The Format Shape task pane opens. 

d.    Type    –  45  in the Rotation box, and then close the task pane. 

e.    Move the  rotated text box  to the right of the diagonal line (see Figure 8-27). 

8.    On the View tab, clear the  Gridlines  check box to turn off gridlines again. 

9.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Selected shapes have selection handles (also called sizing handles) that you can use to adjust the 
size of the object. Some complex shapes have yellow diamond adjustment handles that allow you 
to modify the shape. Drag a selected shape anywhere on a slide to reposition it. 

 Lines and other shapes take their color from the current theme. You can change the color, as well 
as change outline and other effects, at any time while creating a drawing. 

 Drawing and Resizing Shapes 

 PowerPoint’s many shape tools allow you to create multisided, elliptical, and even freeform shapes. 
The Shapes gallery contains well over 100 different shapes. Just select a shape and then drag on 
the slide to draw it there, or click on the slide to create a shape with a default size and orientation. 

 When creating shapes, you can simply “eyeball” the size, use the rulers or gridlines to help you 
size, or use the Height and Width settings in the Size group on the Drawing Tools Format tab to 
scale the objects. Setting precise measurements can help you maintain the same proportions when 
creating objects of different shapes, for example, when creating circles and triangles that have to 
be the same height and width. You can also constrain a shape while drawing it by holding down 
the Shift key to maintain its aspect ratio. In the following exercise, you will draw some basic 
shapes. 

STEP BY STEP  Draw and Resize Shapes 

  USE  the  Exhibits Final     Version 3  presentation that is still open from the previous exercise. 

As you work, refer to Figure 8-28 to help you position and size objects. 

1.    On the Home tab, click  Shapes , and then click the  Rectangle  tool. Hold down the  mouse 

button , and drag to  create the tall  er     rectangle    above the horizontal line (see Figure 8-28). 

 How do you resize a shape? 

2.2.3

 How do you insert a shape? 

2.2.4
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2.      With the shape still selected, click the  Drawing Tools Format  tab. Note the 

 measurements  in the Size group. If necessary, adjust the size so the shape is  1 inch 

high  by  0.9 inches wide . 

3.    Select the  Rectangle  tool again and use it to create the wider rectangle shown in Figure 

8-28. This shape should be 0.7 inch high by 1.2 inches wide. 

4.    Select the  Oval  tool, hold down  Shift , and draw the  circle  shown in Figure 8-28. This 

shape should be 1 inch high and wide. 

5.    Click the  Rectangle  tool and create a rectangle  0.7 inches high  by  1 inch wide  near the 

lower end of the diagonal street. 

6.    Click the  shape’s   rotation handle  and drag to the  right to rotate the shape  so its bottom 

side is parallel to the diagonal road (see in Figure 8-28). 

7.    Click the  Freeform  tool in the Lines section in the Shapes gallery. Near the bottom of 

the slide (so you can easily see the line you are drawing), draw an  irregular oval shape  

to represent a lake. The shape should be about 1.4 inches high and 1.5 inches wide. 

 When using the Freeform tool, if you return to the exact point at which you started drawing, 
PowerPoint will automatically close and fi ll the shape with color. If your shape does not fi ll, 
double-click to end it, click Undo, and start again. 

8.    Drag the  lake shape  to the right of the diagonal line (see Figure 8-28). 

9.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 You can save yourself some time when drawing similar or identical shapes by copying shapes. Copy 
a selected shape, use Paste to paste a copy on the slide, then move or modify the copy as necessary. 
You can also select a shape, hold down the Ctrl key, and drag a copy of the shape to a new location. 

 If you are creating a drawing in which you want to show connections between objects, you can use 
connectors from the Lines group of the Shapes gallery. Connectors automatically snap to points on 
shape sides, so you can easily draw an arrow, for instance, from one shape to another. As you reposition 
objects, the connectors remain attached and adjust as necessary to maintain the links between shapes. 

 Adding Text to Shapes 

 You can often improve a drawing by labeling the shapes to state what they represent. In Power-
Point, you can add text by simply clicking and typing the text. When you add text to a shape, the 

Troubleshooting

Figure 8-28

Basic shapes have been added 
to the map
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shape takes the function of a text box. PowerPoint automatically wraps text in the shape as in a 
text box; if the shape is not large enough to display the text, words will break up or the text will 
extend above and below the shape. You can solve this problem by resizing the shape or changing 
the text’s size. You can use any text formatting options you like when adding text to shapes, just 
as when inserting text into a placeholder or text box. To select text in a shape to edit it, drag over 
it with the I-beam pointer. In the following exercise, you will add some text to shapes. 

STEP BY STEP  Add Text to Shapes 

  USE  the  Exhibits Final   Version 3  presentation that is still open from the previous exercise. 

1.  While still on  slide 8 , click in the  tall  er   rectangle  above the horizontal street, and then 

type  West Bank Center . 

2.    Click in the  wide rectangle shape , and then type  Baldwin Museum .  

3.  Click in the  circle shape , and then type  Miller Arena . 

4.    Click in the  rotated rectangle , and then type  Holmes College . Note that the  text is 

rotated  as well. 

5.  Click in the  freeform lake object , and then type  Magnolia Lake . 

6.    Adjust the  widths  of any of the shapes as needed so that the text fi ts in them. 

7.  Drag over the  Baldwin     Museum    text to select it, and then click the  Bold  button to 

boldface the text. Your map should look similar to Figure 8-29. Figure 8-29

The map with text added to 
the shapes
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8.     SAVE  the presentation. 

    PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 To adjust the way text appears in a shape, right-click the shape, click Format Shape, click Text 
Options, click the Textbox icon, and access the Text Box settings in the Format Shape task pane. 
For example, you can align the text vertically and horizontally within the shape. 

 Formatting Shapes 

 You can apply many of the same formatting effects to drawn lines and shapes that you apply to 
other objects in PowerPoint. For example, you can change the fi ll color or texture, add borders, 
and use effects such as shadows and bevels. You can also apply Shape Styles to save time by for-
matting a shape using a preset. In the following exercise, you will format shapes by changing their 
borders, fi lls, and effects and by applying Shape Styles.  

STEP BY STEP  Format Shapes 

  USE  the  Exhibits Final Version 3  presentation that is still open from the previous exercise. 

1.    On the drawing on slide 8, format the  Matthews Pike  line and label as follows: 

a.    Click the  vertical line  that represents Matthews Pike. 

b.    On the Drawing Tools Format tab, click the  Shape Outline  button, and then click the 

 Gold, Accent 3  theme color. 

 You can use the Shape Outline button in the Drawing group on the Home tab or in the Shape 
Styles group on the Drawing Tools Format tab. 

c.    Click the  Shape Outline  button again, point to  Weight , and click  6 pt . 

d.    Click the  outside border  of the Matthews Pike text box to select all content in the text 

box, and on the Home tab, click  Font Color , and click  Black  ,   Background 1 . 

e.    With the text box still selected, click the  Shape Fill  button, and then click  White  ,   Text 1 . 

f.      Drag the  text box  to the left slightly if needed so that it does not overlap the vertical 

line. 

2.    Click the  horizontal line  and repeat  steps 1a  -  1c  to format the line with the  White  ,   Text 1  ,   

Darker 35%  theme color and  6 pt  .  weight. (Do not worry if the street overlaps over the 

 Matthews Pike  text box. You will learn to fi x this problem in a later exercise.) 

3.  Click the  diagonal   Magnolia Parkway  line, click the  Shape Outline  button, point to 

 Weight , and click  6 pt . 

4.    Format the  Magnolia Parkway  text box following  steps 1d  and  1e  to change text to 

black and the fi ll to white. 

5.    Format the  other shapes  as follows: 

a.    Click the  West Bank     Center   shape  above the horizontal street, hold down  Shift , and 

click  each additional fi lled shape  until all are selected. (Do  not  click any of the lines 

or the street name text boxes.) 

b.    Click  Shape Outline , and then click  No Outline . You have removed outlines from the 

selected shapes. 

c.    Click the  More  button in the Shape Styles group, and click the  Intense Effect - Black  ,   

Dark 1  effect (the fi rst style in the last row). 

d.    Click  away from the shapes  to deselect them all, and then click the  Baldwin     Museum   

shape  to select it. 

e.    On the Drawing Tools Format tab, click  Shape Fill , and click  Pink  ,   Accent 2  ,   Darker 25% . 

f.  Click  Shape Effects , point to  Preset , and click  Preset 1 . 

 Take Note 

 How do you apply borders to 
shapes?  

2.2.2

 How do you apply styles to 
shapes? 

2.2.6

 Take Note 
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6.     Apply a   texture   to the   Magnolia     Lake   shape by doing the following:  

a.    Click the  Magnolia     Lake   shape . 

b.    On the Drawing Tools Format tab, click  Shape Fill , point to  Texture , and click the 

 Water Droplets  texture. 

c.    Click the  Text Fill  button’s arrow to open its palette and click  Black  ,   Background 1 .  

7.    Click away from the  Magnolia     Lake   shape  to deselect it. Your map should look similar 

to Figure 8-30. 
Figure 8-30

The map has been formatted

8.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 By now, you should be familiar with applying fi lls, outlines, and effects. You can format shapes 
using these options just as you formatted table cells, chart data markers, and SmartArt shapes in 
previous lessons. 

 Note that you can access fi ll, outline, and effect options from either the Home tab or the Drawing 
Tools Format tab. PowerPoint makes these options available on both tabs to minimize the amount 
of switching you have to do if you are also formatting text. 

 Save time when applying the same kinds of formats to a number of objects by selecting all the 
objects that need the same formatting. You can then apply the format only once to modify all the 
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selected objects. To select several objects, you use the Shift-click method: click the fi rst object you 
want to select, hold down the Shift key, and then click additional objects. If you select an object 
for your group by mistake, click it again to exclude it from the selection group. 

 Creating a Custom Shape 

 One of the most welcome new features in Offi ce 2013 is the ability to combine multiple drawn 
lines and shapes together into more complex shapes. This feature makes the drawing tools in Of-
fi ce applications much more useful and fl exible. You can overlap two or more shapes and then issue 
a command that combines them. There are several different commands for creating custom 
shapes, each of which produces a different combination effect. In this exercise you will combine 
several shapes to create a custom shape for use in a logo. 

 STEP BY STEP Create a Custom Shape 

  USE  the  Exhibits Final   Version 3  presentation that is still open from the previous exercise. 

1.    Go to  slide 1 , and on the  Insert  tab, click  Shapes , and then click the  8  -Point Star  in the 

Stars and Banners section of the shape list. 

2.    Hold down the  Shift  key and drag on the  slide , above the text, to  draw a star  that is 

approximately  2"  in both height and width. 

3.    On the  Insert  tab, click  Shapes , and then click the  crescent moon shape . Drag to draw it 

over the  8-point star  (see Figure 8-31). 

  How do you create a custom 
shape?  

2.2.5

Figure 8-31

Draw the crescent moon over 
the 8-point star

4.    Click the  8-point star , hold down  Shift , and click the  crescent moon shape . Both are 

selected. 

5.  On the Drawing Tools Format tab, click the  Merge Shapes button . A menu opens (see 

Figure 8-32). 
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6.     Point  to each of the menu options to see that effect previewed on the shape. 

7.      Click  Combine . The two shapes are combined such that the area where they 

overlapped is removed (see Figure 8-33). 

Figure 8-32

Open the Merge Shapes menu

Figure 8-33

The shapes have been 
combined using the 
Combine command

8.        Select the  shape , and on the Drawing Tools Format tab, click  Shape Fill  and click  Light 

Blue  ,   Text 2  ,   Darker 90%  .  

9.      Click  Shape Outline  and click  No Outline . 

10.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 As you saw in step 6, there are many options for merging shapes. These options are summarized 
in Table 8-1. 
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 ORDERING AND GROUPING SHAPES 

 It is not uncommon to have to adjust the layout of objects you have added to slides. You may fi nd 
that objects need to be reordered so they do not obscure other objects, or need to be aligned on the 
slide to present a neater appearance. You can also group objects together to make it easy to move 
or resize them all at once. 

 Setting Object Order 

 Objects stack up on a slide in the  order    in which you created them, from bottom to top. If you 
insert a slide title on a slide, it will be the object at the bottom of the stack. The last item you cre-
ate or add to the slide will be at the top of the stack. You can envision each object as an invisible 
layer in the stack. You can adjust the order in which objects stack on the slide by using Arrange 
commands or the Selection pane. 

 Some objects can obscure other objects because of the order in which you add them to the slide. 
You use the Order options to reposition objects in the stack: 

•   Bring to Front  :   the selected object to the front or top of the stack, on top of all other objects.  

•   Bring Forward  :   an object one layer toward the front or top of the stack. Use this option if you 
need to position an object above some objects but below others.  

•   Send to Back  :   an object all the way to the back or bottom of the stack, below all other objects.  

•   Send Backward  :   an object one layer toward the back or bottom of the stack.  

  In this exercise, you will arrange some objects by changing their stacking order.  

 STEP BY STEP Set Object Order 

  USE  the  Exhibits Final   Version 3  presentation that is still open from the previous exercise. 

1.  Go to  slide   1 , and draw a  new rectangle  that covers the logo. 

a.  On the Home tab, click  Shapes , and click  Rectangle . 

b.   Drag  to  draw a   square  over the existing logo. Hold down  Shift  to constrain the 

rectangle to make it a square. 

c.  On the Drawing Tools Format tab, adjust the  Height  and  Width  of the rectangle so 

that its height and width are equal and just large enough to cover the logo. 

d.  Click  Shape Fill , and click  Gold  ,   Accent 3 . 

e.  Click  Shape Effects , point to  Bevel , and click  Circle .  

The Bottom Line

 How do you align and group 

shapes? 

2.3.3

Operation Description Example

Union Combines the areas of both shapes, and takes on the 

formatting of the top shape

Combine Includes areas where one of the two shapes appear, but 

excludes areas where both shapes overlap

Fragment Combines the areas of both shapes, but breaks the shapes 

into multiple pieces where overlap begins and ends

Intersect Includes only the areas where the top shape overlaps the 

bottom shape

Subtract Includes only the areas where the top shape did not overlap 

the bottom shape
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2.  On the Drawing Tools Format tab, click  Send Backward  (see Figure 8-34). The rectangle 

moves behind the star/moon shapes. Do not worry if they are not neatly aligned with 

one another; you will learn how to align them later in this lesson. 
Figure 8-34

Move the rectangle behind the 
logo graphic

Click Send Backward

3.    Go to  slide 8 . On the Home tab, click the  Arrange  button, and then click  Selection Pane . 

The Selection task pane opens (see Figure 8-35), showing the current slide content in 

the order in which it was created, from bottom to top. This order is determined by the 

order in which the objects were added to the slide.  
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 The Arrange tools are available on both the Home tab and the Picture Tools Format tab. 

 Do not be concerned if the list in your Selection pane does not exactly match the one shown in 
Figure 8-35. The order and numbering of objects in the pane can be affected by many actions. 

4.  Click the gold  Matthews Pike street   line  in the map to see how it is identifi ed in the 

Selection pane—it will have a name such as  Straight Connector   7  (or some other 

number). Then click the  horizontal street line  to see its name. 

5.  Click the    Matthews Pike street   line  again to select it. If that line is not already on top of 

the horizontal street line, click the  Bring Forward   arrow  (the up arrow button) in the 

Selection task pane until it is.  

6.  Click the  Matthews Pike text box  and click the  Bring Forward   arrow  until the text box is 

on top of the horizontal gray line in the map if was not already so. 

7.  Click the  Magnolia Parkway street line  and click the  Bring Forward   arrow  until the 

diagonal street is above the horizontal street in the map if it is not already so. Then 

close the  task pane . 

8.  You have one more shape to add to the map: an arrow that labels the horizontal street 

as John Street and indicates that the street is one way. Click  Shapes  on the Home tab, 

click  Right Arrow  in the Block Arrows group, and draw a block arrow (see Figure 8-36). 

The arrow should be about 0.7 inches high and 5 inches wide. 

Take Note

Troubleshooting

Another Way
You can also use 

the Bring Forward button on 
the Drawing Tools Format tab 
in step 6.

Figure 8-35

The Selection pane shows the 
current slide content

Selection pane
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9.  In the arrow, key  John Street   -   ONE WAY .  

10.    On the Home tab, click  Align Left  to make the text align on the left side of the arrow. 

11.  Using the Shape Fill button, apply the  Green  ,   Accent 1  ,   Darker 50%  color to the arrow. 

12.   Right-click  a blank area of the block arrow (to the right of the words  ONE WAY , for 

example), point to  Send to Back , and click  Send to Back . The arrow moves behind all 

lines and shapes. 

13.  Click the  Bring Forward  button on the Drawing Tools Format tab until the arrow is in 

front of the diagonal line representing Magnolia Parkway but the behind Magnolia Lake 

shape. Figure 8-37 shows the completed map. 

Figure 8-36

Draw a block arrow

Block arrow

Figure 8-37

The completed map

14.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 
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 You can clearly see the stacking order of objects on a slide using the Selection pane. This pane is 
similar to the Layers palette in a program such as Illustrator or Photoshop. It allows you to easily 
move objects up or down in the stacking order. You can click the visibility “eye” to hide objects 
that might be in your way as you work on another object—a handy feature when creating a com-
plex drawing. 

 If you do not want to use the Selection pane, you can use options on the Home tab’s Arrange 
button menu to reorder objects, or you can use buttons on the Drawing Tools Format tab in the 
Arrange group. You can also access these options readily by right-clicking an object and selecting 
the appropriate command from the shortcut menu. 

 Arrange options also display on other Format tabs, such as the Picture Tools Format and SmartArt 
Tools Format tabs. 

 Aligning Objects with Each Other 

 Your drawings will present a more pleasing appearance if similar items are aligned with each  other 
or to the slide. Use PowerPoint’s alignment options to position objects neatly. 

 PowerPoint’s alignment options allow you to line up objects on a slide both horizontally and 
vertically: 

•   Use   Align Left  ,     Align     Center  , or   Align Right   to align objects horizontally so that their left 
edges, vertical centers, or right edges are lined up with each other.  

•   Use   Align Top  ,   Align Middle  , or   Align Bottom   to align objects vertically so that their top 
edges, horizontal centers, or bottom edges are lined up with each other.  

 You can also use distribute options to space objects evenly, either vertically or horizontally. This 
feature can be a great time-saver when you have a number of objects that you want to spread out 
evenly across a slide. 

 PowerPoint allows you to align (or distribute) objects either to each other or to the slide. If you 
select Align Selected Objects on the Align menu, PowerPoint will adjust only the selected objects. 
If you select Align to Slide, PowerPoint will rearrange objects using the entire slide area. 

 STEP BY STEP Align Objects with Each Other 

  USE  the  Exhibits Final   Version 3  presentation that is still open from the previous exercise. 

1.    On slide 8, click the  West Bank     Center   shape , hold down  Shift , and click the  Baldwin 

Museum  shape and the  Miller Arena  shape. These landmarks are all different distances 

from the  John Street  horizontal line but can be aligned for a neater appearance. 

2.    Click the  Drawing Tools Format  tab if necessary, and in the Arrange group, click  Align   

Objects , and click  Align   Bottom  (see Figure 8-38). The shapes are now aligned at the 

bottom so they are the same distance from the horizontal line. 

3.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Take Note 
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 Grouping Objects  

 When a drawing consists of a number of objects, it can be tedious to move each one if you need to 
reposition the drawing. Grouping objects allows you to work with a number of objects as one unit. 
In the following exercise, you will group objects into a single unit. 

 STEP BY STEP Group Objects  

  USE  the  Exhibits Final   Version 3  presentation that is still open from the previous exercise. 

1.    While still on slide 8, click  above and to the left of the map  (but below the line of text), 

and then hold down the  left mouse button  and drag downward and to the right until 

you have included the entire map in the selected area. This action is called  lassoing  the 

shapes. 

2.    Release the  mouse button . All the shapes within the selection lasso are selected. 

3.    Click the  Drawing Tools Format  tab. Click the  Group   Objects  button, and then click 

 Group  (see Figure 8-39). All objects are surrounded by a single selection border. 

Figure 8-38

Align the selected shapes at 
their bottoms

Figure 8-39

Use the Group command to 
group the selected shapes
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4.     SAVE  the presentation and  CLOSE  the fi le. 

  PAUSE .  LEAVE  PowerPoint open to use in the next exercise. 

 If a drawing contains a number of objects, it makes sense to group the objects when you are fi n-
ished with the drawing. You can more easily reposition a grouped object, and you can also apply 
formatting changes to all objects in a group much more quickly than by applying formats to each 
individual object. To select a group, click any object in the group. 

 If you fi nd that you need to work further with one object in a group, you can simply click it to 
activate it. It remains part of the group while you modify it. Most modifi cations are possible with-
out ungrouping. (Exception: You cannot move the object separately from its group.) If you need 
to remove objects or make sweeping changes to a group, you can use the Ungroup option to release 
the group into its component parts. PowerPoint remembers the objects that are in the group so you 
can use Regroup if desired to restore the group. 

 If you are creating a very complex drawing, you can group portions of the drawing, and then 
group those groups. This makes it easy to reuse portions of a drawing—simply ungroup the entire 
drawing, copy the group you need elsewhere, and regroup the whole. 

 It is easy to miss an object when selecting parts of a complex drawing to create a group. To check 
that you have all objects selected, move the group. You will easily see if one or more objects do not 
move with the group. Undo the move, click the group, click any other objects that need to belong 
to the group, and issue the Group command again. 

 CREATING A PHOTO ALBUM PRESENTATION  

 PowerPoint can create a special type of presentation for situations where the primary purpose is 
to display photos. Photo album presentations are easy to create and modify using a dialog box 
interface. 

 Creating a Photo Album Presentation 

 A photo album presentation is useful when you want to showcase multiple photographs. This 
special presentation type enables you to set up consistent formatting that will apply to every photo 
in the presentation automatically. You can also specify captions for the pictures and display them 
in color or black and white. In the following exercise, you will create a photo album presentation. 

 STEP BY STEP Create a Photo Album Presentation 

  GET READY . Before you begin these steps, start PowerPoint. You do not have to start a 

new presentation, because you will create one as part of the exercise. 

1.    On the Insert tab, click  Photo Album . The Photo Album dialog box opens. 

 Even though you are using the Insert tab, you are not actually inserting the photo album into the 
existing presentation; instead, you are creating a brand-new presentation fi le. 

2.    Click the  File/Disk    button. The Insert New Pictures dialog box opens. 

3.    Navigate to the  location  where the data fi les for this lesson are stored, and click 

 Astronomy.jpg.  

4.    Hold down the  Ctrl  key and click the following fi les:  Biology.jpg  ,   Chemistry.jpg  ,  

Circuit.jpg ,  Satellite.jpg  ,   Shuttle.jpg ,   and  Telescope.jpg  (see Figure 8-40). 

 Take Note 

The Bottom Line

 Take Note 
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5.    Click  Insert . The Photo Album dialog box reappears, with all the selected pictures listed 

(see Figure 8-41). 

Figure 8-40

Select multiple graphic fi les 
for inclusion

Figure 8-41

The selected photos are now 
listed in the Photo Album 

dialog box

6.    Click the check box for the  Circuit.jpg  graphic on the list, and then click the  Move Up  

arrow three times to move it to the fi rst position in the list. Then clear its  check box . 

7.    Click  New Text Box . A text box entry is inserted on the list of graphics between

Circuit.jpg and Astronomy.jpg. 

8.    Click the check box for the  Shuttle.jpg  graphic, and then click the  Rotate Right  button 

to rotate it  90 degrees  in a clockwise direction. Then clear its check box. 

9.    Click the check box for the  Satellite.jpg  graphic, and then click the  Increase Brightness  

button twice to brighten the image. Then clear its  check box . 

10.    Click the check box for the  Biology.jpg  graphic, and then click the  Increase Contrast  

button to increase the image contrast. Then clear its  check box . 

11.    Open the  Picture Layout  :     drop-down list  and click  1 Picture . 
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12.    Open the  Frame Shape  :   drop-down list  and click  Rounded Rectangle . 

13.    Click to mark the  Captions   b  elow ALL   p  ictures  check box. 

14.    Click  Create . The presentation is created. 

15.    Browse through the  presentation  to see what has been created. Notice that  each picture  

has a caption under it that shows the fi le name (minus the fi le extension). Notice that 

the text box has been placed on its own separate slide, just as if it were a picture. 

16.    On the Insert tab, click the arrow next to the  Photo Album  button, and on the menu that 

appears, click  Edit Photo Album   . The Edit Photo Album dialog box opens. It is similar 

to the Photo Album dialog box in Figure 8-41. 

17.    Open the  Picture Layout  :   drop-down list  and click  2 Pictures . 

18.    Click the  Browse      button next to Themes. Click the  Ion  theme and click  Select . 

19.    Click the  ALL pictures black and white  check box. 

20.    Click  Update . The dialog box closes and the changes are refl ected in the presentation. 

21.    Browse through the  presentation  to see what has been changed. 

22.     SAVE  the presentation as  Photo Album Final . 

  EXIT  PowerPoint. 

 A photo album presentation is different from a regular presentation fi le. You could create the same 
end result using a regular presentation, but it would not be as easy to reformat and manipulate 
later. Using the Photo Album dialog box, you can easily reorder the pictures, choose whether or 
not to display captions, add text boxes, and more. You can also apply quick adjustments to photos, 
such as brightness and contrast changes and rotations. 

 You must create photo album presentations from scratch; an existing presentation cannot be con-
verted to a photo album.  

 SKILL SUMMARY  

In This Lesson, You Learned
How To: Exam Objective

Objective 
Number

Insert and Format Images Display gridlines.

Crop images.

Resize images.

Apply styles.

Apply effects.

Compress media.

2.3.4

3.5.2

3.5.1

3.5.4

3.5.3

5.3.4

Add Shapes to Slides Resize shapes.

Insert shapes.

Apply borders to shapes.

Apply styles to shapes.

Create custom shapes.

2.2.3

2.2.4

2.2.2

2.2.6

2.2.5

Order and Group Shapes Align and group shapes. 2.3.3

Create a Photo Album Presentation
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    Knowledge Assessment 

 Matching 

 Match the term in Column 1 to its description in Column 2. 

Column 1      Column 2  

 1. Order  a. Pre-drawn graphics you can use to illustrate a slide

 2. Clip art  b. The relationship of width to height for a picture

 3. Guides  c.  A descriptive word or phrase you can use to search for 

 specifi c types of objects 

 4.     Constrain  d. Sizing to a percentage of the original size

 5. Aspect ratio  e.  A special type of presentation fi le designed to display 

images

 6. Scaling  f.  To force a drawing tool to create a shape such as a perfect 

square or circle

 7. Keyword  g.  A series of vertical and horizontal dotted lines that help you 

align objects on a slide

 8. Crop  h. To move one object behind or in front of another

 9.  Photo Album  i. To remove portions of a picture you do not need

 10. Gridlines  j.  Non-printing lines that you can move or copy to help you 

position objects on a slide

   True/False 

 Circle T if the statement is true or F if the statement is false. 

  T   F     1.  When adding clip art to a slide, you are limited to the pictures stored on   your 

computer. 

    T   F     2.  When you use the Union option when merging shapes, only the area         where the 

two shapes overlap is included in the merged shape. 

    T   F     3.  As you move the pointer, a short dotted line also moves on both rulers. 

    T   F     4.  The Recolor option lets you select colors in a picture and replace them   with 

other colors. 

    T   F     5.  Compressing an image reduces the number of colors used. 

    T   F     6.  The color of a new shape is determined by the default shape formatting.  

    T   F     7.  To add text to a shape, select the shape and begin typing. 

      T   F     8.  If you want an object to be at the bottom of a stack of objects, you would   use 

Send to Back. 

    T   F     9.  You can format a single object in a group without having to ungroup   all objects. 

    T   F     10.  Any presentation can be converted to a photo album presentation. 
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   Competency Assessment 

 Project 8-1: Get the Picture  

 You are a recruiter for Woodgrove Bank, and you have prepared a presentation to be delivered at a 
local job fair. You need to locate a picture to illustrate one of the presentation’s slides. You can use 
Microsoft Offi ce clip art fi les to fi nd a suitable picture. 

GET READY. LAUNCH  PowerPoint if it is not already running. 

1.     OPEN  the  Job Fair  presentation and save it as  Job Fair Final . 

2.    Go to  slide 5  and click the  Online Pictures  icon in the right-hand content placeholder. 

3.    Type  business  as the keyword in the Offi ce.com Clip Art box and press  Enter . 

4.    Review the  results  to fi nd a photograph of a professionally dressed business person. 

Click the  picture , and then click  Insert  to insert it into the placeholder. 

5.    Use the  Size options  on the Picture Tools Format tab to resize the picture to be  3 inches 

wide . 

6.    Click the  View  tab, and then click  Gridlines  .  Use the gridlines to  align  the top of the 

picture with the top of the text in the left-hand placeholder. 

7.    Click the  picture  to select it, click  Picture Effects  on the Picture Tools Format tab, point 

to  Shadow , and click the  Offset Right shadow effect  under the Outer heading. 

8.    Hide the  gridlines . 

9.     SAVE  the presentation. 

  LEAVE  the presentation open for use in the next project. 

 Project 8-2: Final Touches 

 You have decided you need another picture in the Job Fair Final presentation. You have a picture 
fi le you think will work. 

1.    Go to  slide 2  of  Job Fair Final  and click the  Pictures icon in the right-hand content 

placeholder. 

2.    Navigate to the  data fi les  for this lesson, locate  Building.jpg , click the  fi le , and click  Insert . 

3.     Right-click  the picture and click  Size and Position   . In the Format Picture task pane, 

scale the picture to  90%  of its current height and width. 

4.    Press  Alt    1  F9  to display drawing guides. Click the  slide title placeholder  to display its 

border, and then drag the  vertical guide  to the right to align with the right border of the 

slide title text box. 

5.    Drag the  horizontal   guide  up to align with the top of the capital letter  E  in the fi rst 

bulleted item in the left-hand guide. 

6.    Reposition the  picture  so that its upper-right corner snaps to the intersection of the two 

guides. Press  Alt    1  F9  to hide the guides. 

7.    Click the  More  button in the Picture Styles group on the Picture Tools Format   tab, and 

then click the  Drop Shadow Rectangle  Quick Style. 

8.     Right-click  the picture, click  Format Picture   , click the  Picture icon , and under Picture 

Corrections, change Brightness to  5%  and Contrast to  10% . 

9.    Click  Compress Pictures  in the Adjust group on the Picture Tools Format tab, and then 

click  E-mail (96 ppi)    and click  OK . 

10.     SAVE  the presentation and then  CLOSE  the fi le. 

  LEAVE  PowerPoint open for use in the next project. 
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 Profi ciency Assessment 

 Project 8-3: Go with the Flow  

 You are a professional trainer teaching a class on basic computer skills. For your class today, you 
need to explain the systems development life cycle (SDLC) to a group of students. You can use 
PowerPoint’s drawing tools to create a fl ow chart that shows the process. 

1.    Create a new, blank presentation . 

2.    Change the title slide to a  Title Only  slide, and type the slide title  Systems 

  Development Life Cycle (SDLC) . 

3.    Draw  fi ve rectangles  stacked vertically on the slide (or draw one and then copy it four 

times). You do not have to worry about alignment or distribution at this point. 

4.    Type  Phase 1: Needs Analysis  in the top rectangle. 

5.    Add  text  to the remaining rectangles as follows: 

     Phase 2: System Design  

     Phase 3: Development  

     Phase 4: Implementation  

     Phase 5: Maintenance  

6.    Resize the  shapes as necessary  so that text fi ts on a single line and all fi ve rectangles 

fi t on the slide with a small amount of space between each shape (see Figure 8-42). 

Figure 8-42

Draw these fi ve rectangles and 
add text to them

7.      Set the width and height of all fi ve rectangles to be  identical  if they are not already. 

8.    With all fi ve rectangles selected, use the  Align Left  command to align them with one 

another. 

9.    Use the  Distribute Vertically  command to equalize the spacing between the rectangles. 

10.    Apply a  different Shape Styles color  to each rectangle. (Use the  same effect  for all 

rectangles, but vary the colors for each.) 

11.     Group  all drawing objects. 

12.    Use the  Align Center  command to align the object horizontally in the center of the slide. 

13.     SAVE  the presentation as  SDLC Final.pptx  and then  CLOSE  the fi le. 

  LEAVE  PowerPoint open for the next project. 
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 Project 8-4: Basic Logo with Stacked Shapes 

 You have been asked by the K-9 Agility Network to create a logo, which they will use as a 
marketing tool. 

1.    Start a new, blank  presentation , and change the layout of the slide to  Blank . 

2.    Draw a  3.5" fi ve-pointed star  on the slide. Hold down  Shift  as you draw it so its height 

and width are the same. 

3.    Apply a  yellow fi ll  to the star. Apply the  Angle bevel  to it from the Shape Effects menu. 

4.      Draw a  4" square  over the star. Apply the  Intense Effect - Blue, Accent 5  Shape Style to 

the square. 

5.     Send the   square   behind the star .  

6.      With both the square and the star selected, use  Align Center  and  Align Middle  to align 

the objects with each other both horizontally and vertically. 

7.       Lasso  the  two objects , and then  group  them. 

8.     SAVE  the presentation as  Logo   Final  ,  and then  CLOSE  the fi le. 

  LEAVE  PowerPoint open for use in the next project. 

 Mastery Assessment 

 Project 8-5: Photo Flair 

 You are fi nalizing a presentation to introduce a speaker and want to do some work on the photo of 
the speaker you have included on a slide. You can use PowerPoint’s picture tools to fi nalize the 
photo. 

1.     OPEN  the  Speaker  presentation and save it as  Speaker Final . 

2.    Go to  slide 2  and  select the   picture . 

3.     Crop  the picture to  remove the coffee cup and newspaper  at the right side of the picture. 

4.     Resize the   photo  so it is  4 inches high  and  align  it with the  top of the vertical line  at the 

center of the slide. 

5.     Increase the   contrast  in the picture by  10% . 

6.     Draw a   rectangle  that exactly covers the picture.  Remove the   outline  from the rectangle. 

7.    Click the  down arrow key   twice  and the  right arrow key   twice  to slightly offset the shape 

from the picture, and then  send the   shape behind   the picture  to act as a drop shadow. 

8.     Choose a   new theme color  for the rectangle shape that contrasts well with the picture 

but does not overwhelm it. 

9.     SAVE  the presentation and then  CLOSE  the fi le. 

  LEAVE  PowerPoint open for use in the next project. 

 Project 8-6: Merging Shapes 

 Your Consolidated Courier presentation needs a new logo. You can create one using the Drawing 
tools in PowerPoint. 

1.    Create a new, blank  presentation . 

2.    Change the layout of the slide to  Blank . 

3.     Draw the   four   shapes  shown in Figure 8-43. 
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4.       Place the   arrow over the top point of the star  (see Figure 8-44). 

Figure 8-44

Place the arrow over the top 
point of the star

Figure 8-45

Create this logo

Figure 8-43

Draw these four shapes, in 
approximately the sizes 

shown here

5.    Use  Merge Shapes , applying the  Union effect , to combine the arrow and the star into a 

single shape. 

6.      Apply the  dark red  standard color to the new shape as a fi ll, and  remove the   shape’s 

outline . 

7.      Select the  banner shape , and fi ll it with the  Dark Red  standard color. Change its outline 

to the  Orange  standard color and set its  Weight     to     1/4   pt . 

8.        In the banner shape, type  Consolidated Courier , pressing  Enter  between the words so 

each appears on its own line. Set the font to  Arial Black . (“Black” is part of the font 

name, not a description of the color. The font color is white.) 

9.       Select the   circle , and fi ll it with the  Moderate Effect - Gold, Accent 4  Shape Style. 

10.       Arrange, align, and size  the  three shapes  into the logo shown in Figure 8-45. 

11.      SAVE  the presentation as  Consolidated Logo   Final  and then  CLOSE  the fi le.

 EXIT  PowerPoint.


